
 

 

 

 

 

 
 

Tutorial project 

 

WindSim 12 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 
 WindSim AS 
 Tollbodgaten 22 
 N-3111 Tønsberg  
 Norway 
 +47 33 38 18 00 
 
 
 
 
 www.windsim.com 

 

 

 

 © 2014 WindSim AS 

                                                                                                  

 

 



   

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

WindSim | Tutorial project 
 

15th Edition | July 2025 
 

WindSim 12 
 
 
 
 
 
 

© 2025 WindSim AS | DUPLICATION PROHIBITED WITHOUT PRIOR PERMISSION 



 

 

 





 

 

 CONTENTS 

Contents 

TUTORIAL PROJECT: HUNDHAMMER ................................................................... 1 

TERRAIN ............................................................................................................................. 2 

WIND FIELDS ......................................................................................................................12 

OBJECTS ...........................................................................................................................16 

Noise calculations ..........................................................................................................21 

RESULTS ............................................................................................................................22 

WIND RESOURCES ..............................................................................................................26 

Wake Modelling .............................................................................................................28 

ENERGY .............................................................................................................................30 

A GRID SENSITIVITY STUDY ................................................................................. 32 

CONFIGURE PARTICLE TRACES IN GLVIEW PRO ............................................. 35 

GENERATION OF THE WIND VISUALIZATION FILE ...................................................................35 

SETTING THE ATTRIBUTES ...................................................................................................36 

CREATING THE PARTICLE TRACES .......................................................................................38 

ANIMATING THE TRACES .....................................................................................................40 

TEXTURES ..........................................................................................................................41 

SAVE AND SHARE ...............................................................................................................42 

CONFIGURE ISOSURFACES IN GLVIEW PRO ..................................................... 43 

GENERATION OF THE WIND VISUALIZATION FILE ...................................................................43 

OPEN 3D VISUALIZATION FILE .............................................................................................43 

SETTING THE ATTRIBUTES ...................................................................................................44 

CREATING THE ISOSURFACES ..............................................................................................45 

TEXTURES - SAVE AND SHARE ............................................................................................46 





 

© 2025 WindSim | DUPLICATION OF THIS DOCUMENT IS PROHIBITED WITHOUT PRIOR PERMISSION 

1  

 

Tutorial Project: Hundhammer 

In this tutorial project we look at the site of Hundhammerfjellet, or simply Hundhammer, 

located on the coast of Norway. The tutorial will guide you through all six modules of 

WindSim, supplying you with the required input. 

 

NOTE: All inputs have suggested default values, which for most cases would be the 

recommended value to use. Whenever a default input value has been modified it is 

highlighted with an orange overlay. 

 

Open WindSim and start a new project by choosing: 

 File > New > Project... 

The New Project window is opened: 

 

 

Figure 1 - New Project window. 

 

Set your project location, which is the folder where your project will be stored, by browsing 

your hard drive, push the button  or use the default path, 

(C:\Users\User_name\Documents\WindSim Projects), give a project name, leave the Layout 

name as Layout 1, and finally enter the name of your customer. If no GWS file is specified, 
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then the grid.gws with the terrain from Hundhammer will be automatically copied from the 

WindSim installation area. In this tutorial, this field is kept empty to load the default terrain 

data. Elevation and Roughness data are read from the .gws file and imported in the new 

WindSim project. Click OK in order to create the project. 

Terrain 

The first step within micrositing is the generation of a 3D model in the Terrain module. This 

involves choosing the horizontal and vertical extension of the volume to simulate. This 

volume, which we will call the computational domain, is then discretized into a system of 

hexahedral cells called a grid or mesh. The computational domain is built based on the digital 

terrain in *.gws format containing information about elevation and roughness. 

 

WindSim can be run either by using the default settings in Properties or by specifying your 

own settings. 

 

NOTE: If you specify a non-default property value, then it is shown in bold type. There are a 

few exceptions to this rule. Properties associated with terrain extensions are always shown in 

bold type as they are project specific, a given default value equal for all projects can’t be set. 

 

In WindSim Evaluation (EV), the maximum number of cells in the vertical direction has been 

set to 10, while the total number of cells in all three directions has been limited to maximum 

50 000. In the commercial version of WindSim, the maximum number of cells would typically 

be limited by the available computer resources. Models with millions of cells can be 

simulated on PCs with a 64-bit operating system. The restrictive limitation in WindSim EV on 

the number of cells used for the computational model means that the results will not have the 

accuracy required for a proper micrositing thus WindSim EV it is not intended for commercial 

work. 

 

Run the Terrain module by clicking on the Start button with the below default settings: 
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Figure 1 - Property settings for the Terrain module with default values for the tutorial project 

Hundhammer. 

 

Upon successful completion, the Module Selector of the Terrain module will have a green 

check and the Description pages will automatically be switched to the Report pages. Some of 

the content in the report is presented below. 
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Figure 3 - Plot from Terrain module report; 2D Field: Elevation. 

 

Click on the black arrows above the plots in the Report pages to visualize various 2D field 

data: 

• Elevation 

• Roughness height (z0) with both linear and logarithmic scale 

• Inclination angle (deg)  

• Second order derivative of the elevation  

• Delta elevation. 

The delta elevation variable gets a non-zero value only when the smoothing option is applied to the model. 

 

Click on 3D Model and the black arrows to visualize: 

• Grid (xy) 

• Grid (z)  

• Open area 
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Grid (xy) and Grid (z) contain information about the grid spacing and number of cells used for 

the discretization in horizontal and vertical directions. 

  

The Open area data is a useful tool to understand if too much blockage has been introduced 

in the generation of the 3D model. A Wind Field simulation can be viewed as a numerical 

wind tunnel test; too much blockage would produce unphysical and therefore unacceptable 

speed-ups. The ratio between minimum and maximum open area is used in the automatic 

generation of the proper height of the 3D model, see the Description pages for details. 

 

When you click on 3D at the upper right of each plot; a 3D model in the visualization tool 

GLview is opened. The 3D visualization option is available for all the sections 2D Fields, 3D 

Model, and Extension. The 3D visualization option is also available in the other modules of 

WindSim. 

There is a separate section in this document that further explores GLview. For now, we only 

explain the basic operations of movement:   

• Translation with left mouse button 

• Rotation with right mouse button 

• Zoom with mouse wheel or both mouse buttons simultaneously 

 

Click on Extension to visualize the horizontal extension of the generated 3D model which is 

marked with a grey frame over an elevation contour map: 
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Figure 4 - Plot from Terrain module report; Extension 

 

The contour map for the Extension is based on the original resolution of the .gws file, thus on 

the maximum possible resolution and not on the 3D model which is coarser than the original 

digital terrain data. The difference in resolution is particularly clear when comparing the two 

plots under 2D Field: Elevation and Extension. 

 

NOTE: If you want to reduce the extension of the model, that is resetting the X- and Y-range 

of the properties given in Figure 2, then it is convenient to use the visualization tool GLview. 

You open GLview by clicking “3D” while Extension is displayed in the report, see figure 5. 

 

Next you should identify the coordinates of the lower left and upper right corner of the new 

reduced model you will establish. In GLview coordinates can be displayed for any cell in the 

grid by selecting the cell with the cursor while pressing down the “Ctrl” button. Note that 

when then “Ctrl” button is held down the cursor changes from and arrow to a plus sign as an 

indication that the selection mode is active. A cell is selected by pressing the left mouse 

button. Pressing the right mouse button allows for selection of properties, chose “Display 
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Polygon info…” and the output would be similar to Figure 5. In Figure 5 a cell with 

coordinates (5500,3000) have been selected. Hence adding 5500 meters to the X-min value 

of the X-range and 3000 meters to the Y-min of the Y-range will establish a model with the 

selected point as the lower left corner. 

 

 

Figure 5 – Displaying cell (polygon) properties in GLview 

The same procedure can be used to select a new upper right corner of your model. For more 

information about the coordinate systems used in WindSim, see the description pages for the 

Terrain module. 

 

In order to produce a higher resolution grid, which means smaller discretization errors in the 

area of interest where the wind farm has to be constructed, a new extraction of a smaller 

area will be done. 

Assign a new extension to the terrain model in the Properties panel by new X-range and Y-

range. Define a refinement area to design an even denser grid in the area of interest, where 

the wind farm has to be located: 
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Figure 6 - Property settings for the Terrain module, reduced area with refinement. 

 

In this way you have cropped from the original .gws file an area only covering the ridge of 

Hundhammer, where the wind farm will be located. The borders of the computational domain 

are still quite far from the area of interest in order to avoid too heavy boundary effects. 

 

NOTE: The X- and Y-range of the refinement area is by default set to be in the centre of the 

model. Whenever a resetting of the X- and Y-range of the total modelled area is done, also a 

resetting of the refinement area should be done to keep the refinement area in the centre. A 

simple way to achieve this is to set the property Refinement area to “No refinement” and then 

reselect it to “Refinement area”. At this stage the X- and Y-range of the Refinement area will 

be based on the newly set X- and Y-range of the total model and you will automatically 

obtain the values given in Figure 6. 

 

Click “Start” on the right-hand side of your screen to run the Terrain module again. 

 

Click on Terrain > Report > Extension to get the Figure 7 and Figure 8 in the Report frame, 

which shows the extension of the new 3D model compared to the original gws terrain data.  

 

NOTE: When refinement is applied, the horizontal resolution varies. Its minimum and 

maximum values are available in the Report > 3D Model and Grid (xy). 
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Figure 7 - The digital terrain model, marked as a box, with given extensions is extracted from 

grid.gws. 

 

Click on Terrain > Report > 3D Model, and then select Grid (xy) using the black arrows to 

obtain the report on the horizontal discretization of the generated 3D Model shown in Figure 

8. 
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Figure 8 - Terrain > Report > 3D Model: Grid (xy) 

 

Click on Terrain > Report > 3D Model and then select Grid (z) using the black arrows to obtain 

the report on the vertical discretization of the generated 3D Model, shown in Figure 9. 
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Figure 9 - Terrain > Report > 3D Model: Grid (z). 

 

Click on Terrain > Report > 3D Model. Then select Open area by using the black arrows to 

obtain what is shown in Figure 10. The criteria named Open area account for the ratio of 

minimum and maximum area of the intersections of the computational domain with vertical 

planes south-north and west-east directed. The wind field simulations can be seen as 

numerical wind tunnel “runs”. So, it is important to reduce the blockage effect which produces 

unphysical speed-up. 

 

NOTE: The ideal height of the 3D model is computed automatically in order to keep this ratio 

above an acceptable value, see Description for details. 
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Figure 10 - Terrain > Report > 3D Model: Open area. 

Wind Fields 

Once the generation of the 3D model has been completed in the Terrain module, the CFD 

simulations of the wind fields can start. The wind fields are determined by solving the 

Reynolds Averaged Navier-Stokes equations (RANS). The standard k- model is one option 

for turbulence closure. The RANS equations are discretized and integrated with a finite-

volume method. Starting with the initial conditions, which are guessed estimates, the solution 

is progressively resolved by iteration until a converged solution is achieved. 

 

There are four possible ways to solve the RANS equations in WindSim: 

• GCV; a General Collocated Velocity method. Very robust. Always delivers a 

converged solution. 

• Parallel GCV; a parallel solver of GCV splitting a numerical model in sub-models and 

use separate CPUs on each sub-model. 

• GCV+HYPRE; HYPRE is a library of high-performance preconditioners and solvers, 

with BoomerAMG. This uses algebraic multigrid (AMG) algorithm for the linear 

equation solver for the GCV algorithm. The new solver setup shows a better 

convergence behaviour for big models run with parallel option. 
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• Parallel GCV+HYPRE; same as above including parallelisation, that is splitting a 

numerical model in sub-models and use separate CPUs on each sub-model. 

For more information concerning the solver you can look at the “Description” in Wind Fields 

module. 

 

Select the Wind Fields module and run the module with default settings. A window will pop 

up to let you follow the development of the wind field during the iterative solution procedure 

The Field value monitored by default is the Speed scalar XYZ at ground level, that is at the 

first Z level, which is the 2D field displayed in Figure 11. If several sectors are solved 

simultaneously on different processors, then one window will open for each sector being 

solved. 

 

 

Figure 11 - One window will pop up for each simultaneous sector being run, by default the 

Field value monitored is the Speed scalar XYZ. 
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By default, the software monitors the magnitude of the velocity vector at the ground level (at 

the centre of the ground adjacent cells). If the simulations have reached a converged 

solution, you should not be able to see any further change in this plot. 

 

In the Report pages you can check whether the modelling has been carried out correctly, by 

inspecting the graphs of the Spot and Residual values for all the solved variables. This is 

shown in Figure 12 and Figure 13. 

 

 

Figure 12 - Wind Fields > Report > Spot Values. 

 

 

Figure 13 - Wind Fields > Report > Residual Values. 

 

The report pages for the Spot and Residual values are completed with three tables regarding 

setting and status of the performed calculations. 
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In the Table 1 on the following page there is a summary of Boundary and Initial Conditions 

adopted for the simulations; Table 2 reports the Calculation parameters and the current 

status of the simulations while the Table 3 provides further information about Physical 

models and output for the wind field simulations. The parameters summarized in these tables 

are all explained in the description pages of the Wind Fields module. 

 

 

Figure 15 - Wind Fields report 

 

In the Wind Fields > Report > Field Value menu, it is also possible to see an animation of 

the development of the chosen variable during the iterative process. In well converged 

simulations, the calculated variables should not change any further as the iterative process 

reaches the end. A screenshot of the monitored variable is shown in Figure 16. 
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Figure 16 - Wind Fields > Report > Field Value. 

Objects 

The Objects module is used to: 

• Place turbines in the wind farm 

• Process climatologies 

• Place transferred climatologies 

 

Geometrical objects can also be placed within the 3D terrain model for visualization 

purposes. At the actual Hundhammer site there are 17 turbines and 2 climatologies. This 

layout is already established. It can be read by using the command: 

Tools > Import objects (.ows)...  

Load the file: 

C:\Program Files\WindSim\WindSim 12.0.0\Data\Objects\Hundhammer.ows 

 

Note that the name "Program Files" might vary according to which operating system you run 

on your computer 

 

17 wind turbines will be added to the park layout. The following window message will pop-up 

if the import is successful: 
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Figure 17 - Successful import of objects from an .ows file. 

 

An alternative to the procedure described is to introduce new objects interactively in the Park 

Layout of the Objects module using the Toolbox on the right-hand side: 

 

 

Figure 18 - Toolbox for interactive manipulation of objects. 

 

with the following tools: 

   Select mode 

  Add turbine mode 

  Add climatology from file 

  Add transferred climatology mode 

  Remove selected object 
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  Remove all 

 

With the Park Layout it is possible to add, drag and drop wind turbines in a graphical window. 

This helps the user to design the park layout and make modifications to it. After adding a 

turbine, it could be moved interactively. Change the position of an object by first activating 

the "Select mode" in the Toolbox. Next, select an object by the clicking the left mouse button, 

the objects are moved with the mouse while pressing the Shift button. 

 

The user still needs to load the climatology files (.wws or .tws), before running the module. 

Load a climatology using the "Add climatology from file" from the Toolbox. Two climatologies 

have been prepared for the site at Hundhammer namely: 0150-Tommerhol-30m_1year.wws 

and 0801-Hundhammer-30m_1year.wws located under the folder: C:\Program 

Files\WindSim\WindSim 12.0.0\Data\Objects\Climatology. Both sets of data are for 

anemometers at 30 meters height and referred to the same measuring period of 1 year. By 

using the "Add climatology from file" these climatologies are copied into the project folder 

structure. 

 

Remark that climatology objects can’t be moved, their position is given in the .wws or .tws 

files. The only way to change the location for a climatology object is to change the 

coordinates in the files. 

 

The Objects module is now ready to run, click on the Start button. The layout of the wind 

farm can be visualized by selecting the Report > Object representation menu. The report for 

the Objects module will appear as in Figure 19 and Figure 20. The main features of the 

climatologies and turbines within the wind farm are listed in the tables 1 and 2 of the report. 

 

Further information on climatologies and turbines are given if the user clicks on the links 

(blue bold type) in the tables. An animation is available which is activated by Report > 

Animation and 3D to open GLview Pro. An animation is also available directly in the Park 

layout. 
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Figure 19 - Objects > Report > Object representation.  

 

 

Figure 20 - Objects > Report > Object representation continued. 
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A photo or texture can be pasted on the terrain to provide a more realistic view of the wind 

farm area. Load the file hundhammerfjellet.bmp by opening Layouts > Terrain texture file 

> Open …. The file is located under the folder:  C:\Program Files\WindSim\WindSim 

12.0.0\Data\Texture. Run the object module again in order to apply the texture. Activation of 

Texture in the Objects module report gives a plot with the photo draped over the terrain as 

seen in Figure 21. 

 

 

Figure 21 - Objects > Report > Object representation with Texture. 

 
Click on 3D objects and open this graphic in GLview by clicking the 3D button. This 

allows various perspective views of the wind farm. At this stage fly-troughs could be 

generated, check out the 3D Samples at the WindSim web site. 
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Figure 22 - Perspective view of the Hundhammer wind farm. 

Noise calculations 

Noise calculations are performed in the Objects module. First, select a wind turbine or a 

climatology and then select Noise calculation>Based on broadband at the “Objects frame”, 

as shown in Figure 23, in order to carry out a noise analysis, which can be output at any 

height, for any wind direction and for any wind speed. The default settings produce a noise 

map in 2 meters' height, for a northern wind of 5 m/s. The wind direction and wind speed are 

by default defined to be the conditions at the Hundhammer climatology. 

 

 

Figure 23 - Example Properties for the CFD noise calculations in the Objects Module 
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Background noise level is set to 0 db so that only the noise contribution from the wind 

turbines is estimated. Local standards or project requirements may require the background 

noise to be included. The attenuation coefficient represents the industry standard for 

broadband noise. More experienced users might wish to adjust this constant to account for 

site specific atmospheric conditions and/or to account for an octave band analysis. 

Run the Object module again by clicking the Start button. 

 

A new set of reports is generated with a separate noise map found under Report > Object 

representation > Noise. The map represents the noise pressure level in dB for all locations 

in the project. 

 

 

Figure 24 - Noise Calculation report 

Results 

In the Results module you can extract 2D horizontal planes with variables stored in the wind 

database. The 2D plane is a so-called “terrain plane”, that is a plane following the terrain but 

at a given height above the terrain. The “terrain planes” can be extracted from ground level 

up to the "Height of reduced wind database" as specified in the Wind Fields module. 

 

In the below “CRT” is used as an abbreviation for “Cartesian”, hence “UCRT”, “VCRT” and 

“WCRT” means the velocity components along the X-axis (West-East), Y-axis (South-North) 
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and Z-axis (Vertical). The following variables and derived variables are available in the wind 

database: 

 

Speed scalar X  Wind speed scalar in the West-East direction, UCRT [m/s] 

Speed scalar Y  Wind speed scalar in the South-North direction, VCRT [m/s] 

Speed scalar Z  Wind speed scalar in the vertical direction, WCRT [m/s] 

Speed scalar XY  Wind speed scalar in 2D, √(𝑈𝐶𝑅𝑇2 + 𝑉𝐶𝑅𝑇2)  [m/s] 

Speed scalar XYZ  Wind speed scalar in 3D, √(𝑈𝐶𝑅𝑇2 + 𝑉𝐶𝑅𝑇2 + 𝑊𝐶𝑅𝑇2) [m/s] 

Velocity vector XY  Wind speed vector in the horizontal plane, (UCRT,VCRT,0) 

Velocity vector XYZ  Wind speed vector in 3D space, (UCRT,VCRT,WCRT) 

Direction scalar  Wind direction in the horizontal plane [deg] 

Direction scalar relative Wind direction in the horizontal plane relative to the incoming 

wind direction [deg] 

Turbulent kinetic energy Turbulent kinetic energy, 𝐾𝐸  [m2/s2] 

Turbulent intensity  Turbulent intensity assuming isotropic turbulence,  

    100 ∗ √
4

3
∗𝐾𝐸

√(𝑈𝐶𝑅𝑇2+𝑉𝐶𝑅𝑇2)
 [%] 

Turbulent dissipation rate Turbulent dissipation rate, 𝐸𝑃 [m2/s3] 

Pressure   Relative pressure minus hydrostatic term [Pa], the relative 

    pressure has a value equal to zero at the outlet of the domain 

Inflow angle  Angle between the wind vector and the horizontal plane [deg] 

Wind shear exponent Exponent alpha of the equation 
𝑠𝑝𝑒𝑒𝑑1

𝑠𝑝𝑒𝑒𝑑2
= (

ℎ𝑒𝑖𝑔ℎ𝑡1

ℎ𝑒𝑖𝑔ℎ𝑡2
)

𝑎𝑙𝑝ℎ𝑎
 [-] 

 

As an example the Velocity vector XYZ and the Turbulent kinetic energy at 50 m height is 

extracted. Remember to press New every time a new variable should be activated: 

 

1. Click New at the “Properties” window. 

2. Choose “Velocity vector XYZ” at the “Normalisation variable” menu. 

3. Click New at the “Properties” window once more. 

4. Choose “Turbulent kinetic energy” at the “Normalisation variable” menu. 
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Figure 25 - Properties panel, Results module, extraction of Velocity vectors 

 

Figure 26 - Properties panel, Results module, extraction of Turbulent kinetic energy 

 

NOTE: The height for the extracted results has been set to the default value of 50 m above 

ground level. Typical heights of interest are the turbine hub height and the height of the wind 

measurements. 

 

NOTE: That the default legend setting of 0;0 sets the minimum and maximum values found 

in each extracted dataset as legend limit. 

 

NOTE: The default number of Sector angles is the same as the set sectors in the module 

Wind Fields. 

 

Run the module by clicking the Start button. The report will display plots of the “Velocity 

vector XYZ” and “Turbulent kinetic energy” for all 12 sectors as shown in Figure 27 and 

Figure 28. In total the report will consist of 24 plots, that is: 2 variables x 12 sectors x 1 height  

= 24 plots. There is a limit of 200 plots that could be generated during one run. Re-run the 

module if the 200-plot limit impose a restriction on your exploration of the various datasets. 
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Figure 27 - Results > Report.  Wind velocity 3D (m/s) for sector 0° at 50 m a.g.l. 

 

 

Figure 28 - Results > Report. Turbulent Kinetic energy (m2/s2) for sector 0° at 50 m a.g.l. 
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If a figure does not reveal sufficient details, then further details can be inspected in the 3D 

viewer by clicking the information page button 3D. The wind field displayed in Figure 27 

indicates a recirculation zone in the mid part of the model, more specifically on the lee side of 

the ridge when wind is coming in from north. Below in Figure 29, the wind field is inspected in 

detail by zooming in on the recirculation in the 3D viewer. Notice that the recirculation zone is 

the reason for the high level of turbulent kinetic energy at the same location, seen in Figure 

40. 

 

 

Figure 29 – Inspection of the recirculation zone for sector 0° at 50 m a.g.l. 

 

It is important to note that the Results module is a tool for visualization of the wind field 

database. To observe how the wind fields are affected by shifting terrain elevation and 

roughness. In the module Results the wind fields are not calibrated against climatology data, 

as such the resulting wind fields reflect the boundary conditions set in the module Wind 

Fields. In the next two modules Wind Resources and Energy, then the wind database will be 

calibrated against climatology data. 

Wind Resources 

The Wind Resources module is used to create wind resource maps at chosen heights. 

 

NOTE: The Results, Wind Resources and Energy modules are independent from each other, 

it is not necessary to run them sequentially. If, for example, you are only interested in the 
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energy production, you can just run the Energy module and it is not needed to run Results 

and Wind Resources first. 

 

At least one visible climatology must exist in the current layout before running the Wind 

Resource module. All sectors defined in a given climatology must exist in the wind database. 

The wind resource map is established by weighting the wind database against the 

climatology. If several climatology objects are available, the wind resource map will be 

weighted against all of them. This is done by an inverse distance interpolation of the 

climatology objects. A wind resource map is also established for each climatology separately.  

 

Run the Wind Resources module to create a wind resource map for the Hundhammer project 

at 50- and 80-meters height with the properties given in Figure 30. 

 

 

Figure 30 - Properties panel of the Wind Resources module. 
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Figure 31 - The wind resource map which is the 2D mean wind speed at 50 m a.g.l. weighted 

against all climatologies. 

Wake Modelling 

If the user is concerned about wake losses in the wind farm (also known as wind park effect), 

one of the 3 wake models can be activated. These wake models can be used both in the 

module Wind Resources, and Energy. A complete description of the models is provided in 

the description page of the Wind Resources module. 
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Figure 32 – Activation of a wake model in the Properties panel of the Wind Resources module. 

 

Activate “Wake Model 1” and re-run the module. The Report now contains new pages, 

displaying the reduced wind speed or the so-called wake deficit, see Figure 33. 

 

 

Figure 33 - Wake deficit at hub height, wake model 1. 
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Energy 

The Annual Energy Production (AEP) is the most important parameter to be estimated in 

most micrositing projects. For a given wind condition, the available power is proportional to 

the third cube of the wind speed. This means that an uncertainty in wind prediction is largely 

increased when computing the available power; so high-quality wind modelling is particularly 

appreciated within micrositing. 

 

Run the Energy module with the default settings except for the activation of a wake model as 

seen in Figure 34. 

 

 

Figure 34 - Properties panel for the Energy module. 

 

The Energy report gives several tables summarizing the AEP including wake losses on the 

wind farm level, see Figure 35, and on a per turbine level. For each climatology object, two 

AEPs are given in the report. 

 

• The first one is obtained from the frequency table of the climatology files. 

• The second is obtained by Weibull fitting the frequency table. 

 

An estimate of the AEP is given per climatology and for all available climatologies, using the 

same interpolation technique as in the module Wind Resources. 
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Figure 35 - Energy report on the wind farm level including wake losses. For more information on a per 

turbine level click on any number in the column “AEP with wake losses”. 

 

There is a 1.67% difference in the estimated AEP when using the two different climatologies, 

((140.8233 – 138.4683)/140.8233)*100 = 1.67%. Ideally there should be no difference in the 

estimated AEPs, but since both the wind measurements and the numerical simulations 

contains errors there will always be discrepancies. 

 

One of the errors associated with numerical simulations stems from the discrete nature of the 

numerical model. In particular if the numerical model has a too low resolution the 

discretization error can be significant. Ideally the numerical model should have a sufficiently 

high resolution, such that a further increase of the resolution would not change the numerical 

results. In this case the numerical model is said to be grid independent. See next section 

where grid independency with respect to AEP is investigated for the Hundhammer project. 
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A Grid Sensitivity Study 

In this section we investigate the effect of discretization errors on the numerical results. We 

use the AEP for the whole wind farm as a metric for the numerical results, comparing the 

AEP obtained for five different numerical models with the number of cells given in Figure 36. 

 

N Nx Ny Nz 

4 370 23 19 10 

24 320 38 32 20 

90 280 74 61 20 

375 000 150 125 20 

750 480 212 177 20 

Figure 36 - Number of cells in models used for grid independency tests 

 

Ideally a so-called grid independent solution is obtained, giving the minimum discretization 

error, when a further increase in the number of cells doesn’t change the AEP. 

 

 

Figure 37 - Report panel for the Energy module, Hundhammer project (~5 000 cells). 

 

 



 

© 2025 WindSim | DUPLICATION OF THIS DOCUMENT IS PROHIBITED WITHOUT PRIOR PERMISSION 

33  

1. 33 

 

Figure 38 - Report panel for the Energy module, Hundhammer project (~25 000 cells). 

 

 

Figure 39 - Report panel for the Energy module, Hundhammer project (~100 000 cells). 

 

 

Figure 40 - Report panel for the Energy module, Hundhammer project (~400 000 cells). 

 

 

Figure 41 - Report panel for the Energy module, Hundhammer project (~800 000 cells) 
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The AEP calculated with the five different models is summarized in Figure 54. Important 

discretization errors are present for the two models with ~5000 and ~25000 cells. 

Considering a grid independency reached with a model of 800 000 cells, a model comprising 

just 5 000 cells gave errors of 20 % for one of the climatology data. The model of size 100 

000 cells provided a good estimation of the AEP, the errors could be considered within 3%; 

considering a grid independency reached with 800 000 cells. 

 

It´s important to stress that the characteristics of a grid which is leading to grid independency 

is its resolution. So, for wider areas, a higher number of cells are required to minimize the 

discretization errors. 

 

 

Figure 42 - AEP for the two climatologies against number of cells used in the 3D models. 
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Configure Particle Traces in GLview Pro 

Generation of the Wind Visualization File 

How to generate a 3D wind visualization file (.vtf) in the menu”3D Visualization” is shown 

below: 

 

 

 

Figure 43 - The .vtf file is generated from the 3D Visualization menu on the toolbar 

 

The generated .vtf file must contain the 3D velocity vector, which is the vector field used to 

establish the particle traces. 

1. Click 3D Visualization > Generate 3D wind visualisation file (.vtf). A DOS pop-

up window will appear. 

2. Type “l” to choose from the list of sectors. 

3. Choose the sector 000 by simply pressing “000”. 

4. Type “1” to transfer the default variables to the .vtf file. 

5. Open the 3D Visualization file by clicking 3D Visualisation>Open 3D wind 

visualization file (.vtf)… and then selecting the 000.vtf file. 
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Activate the VELOCITY_3D as vector by pressing the “Apply” button as shown in Figure 44. 

The max and min values of the chosen scalar and vector fields will appear in the blue info 

window in the lower right corner: 

 

Figure 44 - Set Vector to VELOCITY_3D and hit Apply in the dialogue box to the bottom left in the 

screen above 

Setting the Attributes 

Zoom in towards the terrain of the model, as shown below. Rotate the model by using the 

right mouse button. Then set the attributes of each part in the “Change Part Attributes…” 

window found under “Model”  

 

Then the grid has to bet set invisible first by choosing “grid” and then unselecting the attribute 

“Visible”. Finish the process by pressing the “Apply” button. 
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Figure 45 - Configure the view to display the relevant parts 

 

In the Change Part Attributes the default setting of all parts which is “Visible” and “Outline 

mesh” could be reset. Selecting all parts is done by clicking on the first part, while holding 

down the shift key clicking on the last part. 

 

While all parts are selected, uncheck the “outline mesh” box and check “smooth shading” to 

give a better visual appearance (see Figure 45). 
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Figure 46  - Perfecting the visualization to your projects specific requirements is easy in WindSim! 

Creating the Particle Traces 

Before calculating particle traces you need to define the start positions for the traces. Each 

trace represents the path of an artificial particle without mass following the wind field in a 

passive manner. In order to get a good representation of the wind field it is convenient to 

specify many traces. This is done by specifying the start positions within a box, with a given 

number of start positions in   x, y, and z direction. To open the window “Particle Traces” click 

Vector > Particle Tracing… (see Figure 47).The dimension of the box will be model 

dependent. In the model below the box is positioned towards the North border as the wind 

field with incoming wind from North has been loaded (000.vtf).  

 

The coordinates (X1,Y1,Z1) and (X2,Y2,Z2) represent the front left bottom point  and the far 

upper right point respectively. In order to specify the dimensions of the box, you need to set 

these coordinates and then click “Apply” (see Figure 48). 
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Figure 47 - Open the dialogue box from the Vector menu on the toolbar 

 

 

Figure 48 - Replicate the settings above to achieve the same particle traces 

 

Under the folder “Options” the user can set the direction for the calculation of the traces. In 

the given case the calculation is only done forward, as the box with starting point is put near 

the inlet border therefore the traces will pass through most of the model.  
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In some cases, the default method for integrating the paths, the Euler method, will fail. If the 

traces do not follow the terrain, but appears like straight lines pointing towards the sky, then it 

is recommended to switch to the linear integration method. 

 

 

Figure 49 - Set the direction of your particle traces 

Animating the Traces 

From the window “Particle Trace” the folder “Startpoint” should be chosen. Then by choosing 

the “Display Setup” button in the upper right corner the window “Particle Trace Display Setup” 

will open.  

 

The setting for animating the particles is set in this window. 

 

• Check the box “Animate” to unlock the animation options. 

• Check the box “Incremental trace” 

• Uncheck the box “Complete trace” 

• Press the “Apply” button. 

 

Try to animate using line (worm) by check the box “Tail”. Play with the settings and see what 

works for your model. 
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Figure 50 - The user has full control over the simulation parameters to design an animation to 

suit any project requirements 

Textures 

The final touch for your presentations is obtained by adding textures. Textures could be 

added to the different parts. For example, adding a satellite photo or a scanned map to the 

DTM (Digital Terrain Model) would make it easier to recognize locations in the model. The 

only purpose of the cylinder surrounding the model is to add a “sky texture”. 

 

A texture is added to a part using the “Change Part Attributes” window introduced above. 

Select the part and then click the button “Texture…”. In the “Texture Settings For Part(s)” 

window, a picture must first be loaded and then this picture must be pasted over the part 

from a given direction, defined by the “Plane”. The picture is stretched over the part if the box 

“Clamp” is checked. Otherwise, a tile pattern is generated. 
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Figure 51- Adding a sky texture greatly enhances the quality of the visualization 

Save and Share 

When you are satisfied with the setting, you can save all the settings to a new .vtf file in the 

menu “File” – “Export to File” – “VTF File…”. Send us your .vtf file and we will publish it at 

windsim.com under: 3D Visualizations (windsim.com) 
 

 

Figure 52 - Just one example of the infinite customizability of WindSim visualization 

https://windsim.com/library/3d-visualizations/
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Configure Isosurfaces in GLview Pro 

Generation of the Wind Visualization File 

Generate a 3D wind visualization file (.vtf) in the menu ”3D Visualization” following the same 

procedure as in paragraph “Configure Particle traces in GLview Pro”. 

 

 

Figure 53 - Locate the menu show above 

 

The generated .vtf file must contain the 3D velocity vector, which is the vector field used to 

establish the particle traces. Moreover, the .vtf has to contain the scalar variable that has to 

be plotted as isosurface. 

Open 3D Visualization file 

Open the 3D wind visualization file (.vtf) in the menu 3D Visualization. Activate SPEED_2D 

as Scalar by pressing the button “Apply”, then the min and max values of the chosen scalar 

fields will appear in the blue info window in the lower right corner (see Figure 54).  
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Figure 54 - Set the Scalar to SPEED_2D and hit Apply 

 

Setting the Attributes 

Zoom in towards the box and rotate the model by using the mouse buttons. Then set the 

attributes of each of the parts in the “Change Part Attributes” window found under “Model” – 

“Change Part Attributes…”. First the grid has to bet set transparent by selecting the grid and 

check the attribute “Transparent” then press the button “Apply” (see Figures 55 and 56); then 

the transparency level has to be put to the maximum value (0.0), click on the Material button 

to set the transparency to 0.0 as shown in Figure 57, then click on OK and Apply to confirm. 
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Figure 55 - Open the Change Part Attributes dialogue box 

 

 

Figure 56 - Replicate the selections made above 

 

 

Figure 57 - Open the Material Properties box by clicking the Material... button 

Creating the Isosurfaces 

Select the “Isosurface...” option under the Scalar menu (see Figure 58). Select the value of 

the loaded scalar that you want to display and press Apply, as shown in Figure 59. Rotate 

and zoom with the mouse to obtain a good view of the flow field. 
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Figure 58 - Open the Isosurface dialogue box from the Scalar menu 

 

 

Figure 59 - The above value generates a nice plot for the Hundhammer project 

 

 

Figure 60 - The Isosurface is now displayed relative to the terrain to visualize the flow in the wind farm 

Textures - Save and Share 

For adding textures and sharing data with others see the procedures described in the above 

section “Configure Isosurfaces in GLview Pro”. 
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Figure 61 - A texture adds a nice touch to the graphics for use in presentation and reports! 


